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Abstract. For decades, the link between poor oral hygiene and 
the increased prevalence of oral cancer has been suggested. 
Most recently, emerging evidence has suggested that chronic 
inflammatory diseases from the oral cavity (e.g., periodontal 
disease), to some extent, play a role in the development of oral 
squamous cell carcinoma (OSCC). The present study aimed 
to explore the direct impact of biofilm‑induced periodontitis 
in the carcinogenesis process using a tobacco surrogate 
animal model for oral cancer. A total of 42 Wistar rats were 
distributed into four experimental groups: Control group, 
periodontitis (Perio) group, 4‑nitroquinoline 1‑oxide (4‑NQO) 
group and 4NQO/Perio group. Periodontitis was stimulated 
by placing a ligature subgingivally, while oral carcinogenesis 
was induced by systemic administration of 4NQO in the 
drinking water for 20 weeks. It was observed that the Perio, 
4NQO and 4NQO/Perio groups presented with significantly 
higher alveolar bone loss compared with that in the control 
group. Furthermore, all groups receiving 4NQO developed 
lesions on the dorsal surface of the tongue; however, the 
4NQO/Perio group presented larger lesions compared with 
the 4NQO group. There was also a modest overall increase 
in the number of epithelial dysplasia and OSCC lesions in 
the 4NQO/Perio group. Notably, abnormal focal activation 

of cellular differentiation (cytokeratin 10‑positive cells) that 
extended near the basal cell layer of the mucosa was observed 
in rats receiving 4NQO alone, but was absent in rats receiving 
4NQO and presenting with periodontal disease. Altogether, the 
presence of periodontitis combined with 4NQO administration 
augmented tumor size in the current rat model and tampered 
with the protective mechanisms of the cellular differentiation 
of epithelial cells.

Introduction

Oral cancer is a major public health problem, with >500,000 
new cases per year worldwide (1). Squamous cell carcinoma 
from the oral cavity and surrounding anatomical areas is 
the most common malignancy from the head and neck area, 
accounting for 90% of all tumors (2). Overall survival rates 
remain low at 50% after 5 years from the initial diagnosis and 
have not improved significantly in the last three decades (3,4). 
Oral squamous cell carcinoma (OSCC) has a multifacto‑
rial origin with several risk factors that act individually or 
in combination (5). The predominant etiological factors for 
OSCC involve tobacco and alcohol consumption, with an 
estimated 5‑fold increase risk for cancer development in heavy 
smokers (2,6,7).

Emerging evidence indicates that periodontitis may 
be an associated risk factor for OSCC (2,5,8,9). In fact, the 
presence of periodontal disease has been associated with an 
elevated risk of lung and colorectal cancer in a population 
study of >7,000 participants (10). Periodontitis represents an 
infection‑induced chronic inflammatory disease that leads to 
irreversible loss of the supporting structures of the teeth. The 
heavy burden of periodontitis is directly associated with its 
high prevalence. Severe periodontitis is estimated to represent 
the 6th most prevalent disease, affecting around 743 million 
people worldwide (11). The biological mechanism by which 
periodontitis could act as a predisposing factor to oral cancer 

Periodontal disease affects oral cancer progression in 
a surrogate animal model for tobacco exposure

TOBIAS R. SPULDARO1,  VIVIAN P. WAGNER2,3,  FELIPE NÖR2,4,   
EDUARDO J. GAIO1,  CRISTIANE H. SQUARIZE4‑6,  VINICIUS C. CARRARD2,7,  

CASSIANO K. RÖSING1  and  ROGERIO M. CASTILHO4‑6

Departments of 1Periodontology and 2Oral Pathology, Federal University of Rio Grande do Sul,  
Porto Alegre, RS 90010‑150, Brazil;  3Academic Unit of Oral and Maxillofacial Medicine and Pathology,  

Department of Clinical Dentistry, University of Sheffield, Sheffield S10 2TN, UK;  4Department of  
Periodontics and Oral Medicine, University of Michigan, Ann Arbor, MI 48109‑1078; 5Laboratory of  

Epithelial Biology, University of Michigan School of Dentistry, Ann Arbor, MI 48109‑1078;  
6Rogel Cancer Center, University of Michigan, Ann Arbor, MI 48109‑0944, USA;  7Department of  

Oral Medicine, Otorhinolaryngology Service, Porto Alegre General Hospital, Port Alegre, RS 90035‑903, Brazil

Received February 11, 2022;  Accepted April 12, 2022

DOI: 10.3892/ijo.2022.5367

Correspondence to: Dr Rogerio M. Castilho, Department of 
Periodontics and Oral Medicine, University of Michigan, 1011 N. 
University Ave., Room ‑ 3150 Commons, Ann Arbor, MI 48109‑1078, 
USA
E‑mail: rcastilh@umich.edu

Key words: head and neck cancer, 4‑nitroquinoline‑1‑oxide, 
periodontitis, ligature, cell differentiation



SPULDARO et al:  CHRONIC ORAL INFLAMMATION MODIFIES CANCER PROGRESSION2

initiation and development is hypothesized in two theories: 
i) The direct involvement of the periodontopathogens; and 
ii) indirectly by inducing a persistent chronic inflammatory 
state (8,9). The constant polymicrobial infection present in 
periodontitis and the associated release of pro‑inflammatory 
mediators are likely to play an important role in the initia‑
tion and/or progression of oral cancer, or at least increase its 
susceptibility (2).

Epidemiological studies present several confounding 
factors that can affect the establishment of an accurate correla‑
tion between periodontitis and oral cancer, such as smoking 
and alcohol consumption. The majority of experimental 
studies trying to establish a direct link between periodontal 
disease and OSCC were performed with cell lines and focused 
on the carcinogenic potential of Porphyromonas gingivalis 
(P. gingivalis), a major pathogen of periodontal disease (12). 
in vivo, experimental studies are still scarce and focus on 
P. gingivalis (13). The results indicate an association between 
P. gingivalis infection and OSCC development (13,14). 
Despite emerging evidence, to the best of our knowledge, 
the in vivo evaluation of biofilm‑induced periodontitis in oral 
carcinogenesis and tumor progression has not been explored. 
Therefore, the present study aimed to analyze the effect of 
ligature‑induced periodontitis on the development of 4‑nitro‑
quinoline 1‑oxide (4NQO)‑induced OSCC in Wistar rats.

Materials and methods

Animals and experimental procedures. The present study 
was performed in accordance with Brazilian Federal Law 
No. 11.794/2008 for the scientific use of animals. The study 
protocol was submitted to and approved by the Animal Use 
Ethics Committee, Porto Alegre General Hospital (Port Alegre, 
Brazil; approval no. 150475). Each sample size calculation for 
the experimental groups was performed based on previous 
studies with a similar methodology. The control group and the 
group with induced periodontitis (Perio) were comprised of 
8 animals each, while the groups receiving 4‑nitroquinoline 
1‑oxide (4NQO) were composed of 13 animals to account for 
the expected mortality rate of ~30% due to 4NQO‑related 
side effects during the 20 weeks of carcinogen administration 
(Fig. 1A) (15‑17).

A total of 42 60‑day‑old male Wistar rats were used in 
the study. Rats were shipped weighing ~250 g, and after the 
acclimation period, rats gained an additional 100 g, therefore 
weighing 350 g at the start date of the experiments (Fig. 1B). 
The rats were provided by the Center for Reproduction and 
Experimentation in Laboratory Animals (Federal University 
of Rio Grande do Sul, Porto Alegre, Brazil) and acclimated 
for 2 weeks at the Animal Experimentation Unit of the Porto 
Alegre General Hospital. Animals were kept under standard 
temperature conditions at 22±2˚C, using a light/dark cycle of 
12 h, with a relative humidity of 50‑70% and free access to 
sterilized rodent laboratory chow (Nuvilab CR1; Quimtia S.A.).

Animals were randomly distributed throughout the four 
groups according to bodyweight: Control (n=8), Perio (n=8), 
4NQO (n=13) and 4NQO/Perio (n=13). Periodontitis was 
induced by placing a 4‑0 silk ligature subgingivally (Ethicon, 
Inc.; Johnson & Johnson). Ligatures were placed around 
the right maxilla second molar under isoflurane anesthesia 

(5% of isoflurane for induction and 2% for maintenance) 
2 weeks before 4NQO administration. Subgingival ligatures 
were kept in place during the experiment (22 weeks) (18,19). 
4NQO solution was used to induce oral carcinogenesis 
according to a previously published protocol (20,21). Fresh 
solutions were prepared every 2 days, and rats were exposed 
to 25 ppm of the 4NQO carcinogen solution (Sigma‑Aldrich; 
Merck KGaA; catalog no. N8141) diluted in drinking water for 
20 weeks (15). Cage water consumption was measured each 
time the solution was replaced (Fig. 1C). Animal weight and 
health status were monitored every other day by the researcher 
and constantly monitored by the vivarium staff and veterinarian 
during the experimental period. There was no evidence of liga‑
ture‑induced disruption of food intake. In total, 2 animals from 
the 4NQO group required early euthanasia using 5% isoflu‑
orane followed by exsanguination during the experimental 
period due to bodyweight loss of 20% as an adverse effect 
advent from 4NQO administration. Death was verified by the 
lack of vital signs, including the absence of respiration and 
heartbeat. Other endpoints considered during the experiment 
included oral tumor burden presenting as disrupted eating and 
drinking behaviors associated with bodyweight loss of 20%. 
Animals from the Control, Perio, 4NQO and 4NQO/Perio 
groups were anesthetized by inhalation of isoflurane (5%), 
followed by euthanasia by decapitation. After euthanasia, the 
tongues and maxillae from the rats were removed and stored in 
10% formalin for 24‑72 h at room temperature.

Determination of lesion surface area. Tumor development 
was assessed on the dorsal area of the tongues. Images were 
captured of each tongue specimen, and the number and the 
size of the lesions were determined (Fig. 1D). Total lesion 
area was measured using ImageJ 1.46r software (National 
Institutes of Health). The area was calculated in pixels and 
converted to mm2 using a scale reference. Briefly, the scale 
was set using the straight‑line tool from the ImageJ toolbar 
over a known scale (i.e., ruler image next to an open image). 
Under Analyze>Set Scale, the known scale was added to the 
‘known distance’ field and ‘Unit of length’ was set in milli‑
meters. Next, all images to be analyzed were transformed into 
8‑bit images (Image>Type>8‑bit). Lesions were delineated 
using the ‘Freehand selections’ tool from the ImageJ toolbar. 
Lesion area was calculated using the analysis tool under the 
menu bar Analyze>Measure. Sequential measurements of all 
lesions were recorded. Additional information on ImageJ tools 
can be found at https://imagej.nih.gov/ij/docs/.

Morphometrical analysis. All maxillae were defleshed using 
9% sodium hypochlorite for 4 h at room temperature, and soft 
tissue was removed carefully. Maxillae were stained for 1 min 
in methylene blue (1%) to outline the cementoenamel junction 
(CEJ). Standardized pictures were captured of the buccal and 
palatal sides of the maxillae and measured using ImageJ 1.46r 
software (National Institutes of Health) (Fig. 1E). Five linear 
points were recorded, and the mean of the values considering 
the distance between the CEJ and the alveolar bone crest 
was considered for bone loss. To ensure that the examiner 
was blinded to the groupings, pictures were randomized 
by a computer program, coded and renamed by an external 
examiner. Approximately 10% of the maxillae were randomly 
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selected and twice measured in terms of alveolar bone loss, 
and compared using the intraclass correlation coefficient, 
which showed excellent results (0.96).

Histological and immunostaining analysis. Tongues were 
embedded in paraffin blocks and longitudinally thin‑sectioned 
(4 µm). The sections were stained with hematoxylin for 4 min 
and eosin for 2 min, at room temperature (Merck KGaA) 
and graded as normal, epithelial dysplasia and carcinoma 
(Fig. 1F and G) by two blinded expert oral pathologists (differ‑
ences in grading were discussed and agreement was achieved). 
Hematoxylin and eosin‑stained slides were scanned using an 
Aperion ScanScope slide scanner (Leica Biosystems).

Immunofluorescence was performed using double staining 
with anti‑cytokeratin 10 (CK10) (clone Poly19054; cat. 
no. 905404; 1:500; BioLegend, Inc.) as the primary antibody for 
1 h at room temperature, followed by use of Alexa Fluor® 568 
(cat. no. A11036; 1:200; Invitrogen; Thermo Fisher Scientific, 
Inc.) as the secondary antibody for 45 min at room tempera‑
ture. DNA was stained using Hoechst 33342 (cat. no. H1399; 
1:5,000; Invitrogen; Thermo Fisher Scientific, Inc.) for 5 min at 
room temperature. Bovine serum albumin (cat. no. 9048‑46‑8; 
MilliporeSigma) diluted to 3% in PBS was used as a blocking 
solution prior to the incubation of primary antibody for 
45 min at room temperature. Images of the entire tongue of 
different groups were captured at x200 magnification using a 
QImaging‑ExiAqua monochrome digital camera attached to 
an epi‑fluorescence Nikon microscope (Nikon Corporation) 
and visualized with QCapturePro 7 software (QImaging; 
Teledyne Photometrics). The Control and Perio groups had 
1 sample per group, and the 4NQO and 4NQO/Perio groups 
had 6 samples per group (2 samples diagnosed with OSCC 
and 4 samples diagnosed with dysplasia). The 4NQO and 
4NQO/Perio groups had a total of 398 fields captured each. 
Images were randomized by a computer program, and coded 
and renamed by an external examiner. A blinded examiner 
analyzed the images by evaluating the presence of CK10 posi‑
tivity in the basal cell layer within each field. The percentage 
of positive fields per experimental group was calculated and 
used for statistical analysis.

Statistical analysis. The variables of this study were tested for 
normality. Data were analyzed using the statistical package 
GraphPad Prism 7 (GraphPad Software, Inc.). Findings were 
reported as the mean ± SEM. One‑way ANOVA followed by 
Tukey's multiple comparison test was used on the alveolar 
bone analysis and weight gain data. Solution consumption data 
were analyzed using one‑way ANOVA followed by Dunnett's 
multiple comparisons test. Unpaired student's t‑test was used 
for tumor size and CK10+ field data analysis. The incidence 
of OSCC was compared using the χ2 test, and the odds ratio 
and the 95% confidence interval were computed using binary 
logistic regression. P<0.05 was used to indicate a statistically 
significant difference.

Results

Weight and solution consumption analysis. Fig. 1A shows a 
flowchart of the study design. All animals gained weight during 
the study (Fig. 1B). Animals exposed to 4NQO consistently 

gained weight during the first 16 weeks of drug administra‑
tion. The modest weight gain during the first 4 weeks of 4NQO 
administration is commonly observed throughout different 
animal models as part of the adaptation process to 4NQO 
intake. A decline in animal weight after 16 weeks of drug 
administration was observed in both groups receiving 4NQO.

During the entire 20‑weeks of 4NQO administration 
significant weight loss was only observed in the 4NQO 
and 4NQO/Perio groups compared with the Perio group 
at week 20 (mean difference, 93.2 and 99.4; P=0.0042 and 
P=0.0022, respectively). When compared with the Control 
group, the 4NQO and 4NQO/Perio groups showed no signifi‑
cant difference throughout the experiment. A parallel may 
be drawn regarding solution consumption. The 4NQO group 
consistently drank less than the control group throughout the 
experiment (Fig. 1C). Significantly lower solution consump‑
tion was observed during weeks 1, 4, 12, 16 and 20 of exposure 
to the carcinogen in the 4NQO group (mean difference, 362.0, 
293.6, 305.4, 307.9, and 396.3; P=0.0156, P=0.0472, P=0.0272, 
P=0.00081 and P=0.0154, respectively), and in the first week 
of exposure in the 4NQO/Perio group (mean difference, 357.0; 
P=0.0168) compared with that in the Control group.

Alveolar bone loss analysis. Alveolar bone loss was measured 
in the second maxillary molar on the right side, in which 
periodontitis was induced using ligatures. The mean level 
of bone loss in the Perio, 4NQO and 4NQO/Perio groups 
(0.57±0.02, 0.57±0.06 and 0.66±0.02 mm, respectively) 
was significantly higher compared with that in the Control 
group (0.38±0.02 mm) (Fig. 2A and B). Unexpectedly, it was 
observed that the administration of 4NQO alone resulted in 
alveolar bone loss similar to that in the Perio group.

Lesion size and histopathological analysis. All groups that 
received 4NQO developed lesions on the dorsal surface of the 
tongue. Images of dissected tongues were captured, and the 
total area of the lesions was identified by an expert pathologist 
and digitally identified and marked with a red ‘mask’ using 
ImageJ to determine the lesion surface area. The mean lesion 
surface area for the 4NQO/Perio group (62.75±9.72 mm2) was 
significantly higher than that observed for the 4NQO‑treated 
group (44.25±6.69 mm2) (Fig. 3A and B). Histological analysis 
revealed that the incidence of epithelial dysplasia and invasive 
squamous cell carcinoma was similar among the 4NQO and 
4NQO/Perio‑treated animals, with a slight increase in the 
number of lesions found in 4NQO/Perio rodents (Fig. 4A). 
Also, both groups developed large tumors characterized by the 
infiltration of the muscle tissue of the tongue and focal poorly 
differentiated tumor areas (Fig. 4B).

Cell differentiation analysis. During the process of the histo‑
logical analysis of tissues from the 4NQO and 4NQO/Perio 
groups, abnormal morphological changes were observed in the 
epithelial layer of the dorsal tongue mucosa receiving 4NQO 
alone. The observed alterations were suggestive of focal 
activation of cellular differentiation that extended near to the 
basal cell layer of the mucosa (Fig. 4C). In order to further 
explore these findings, the expression of CK10, a known 
marker of epithelial cell differentiation, was assessed in the 
rats receiving 4NQO and 4NQO/Perio. CK10 is normally 
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Figure 1. Study methodological aspects. (A) Study flowchart according to experimental groups. All groups were acclimated for 2 weeks. Periodontitis was 
induced by ligature in the Perio and 4NQO/Perio groups 2 weeks before 4NQO exposure. The 4NQO and 4NQO/Perio groups were exposed to 4NQO 
carcinogen in the drinking water for 20 weeks. (B) Weight of rats in experimental groups every 4 weeks during the 20 weeks of 4NQO exposure (**P<0.01). 
(C) Solution consumption of rats in different groups every 4 weeks during the 20 weeks of 4NQO exposure. Data are presented as the mean ± SEM (*P<0.05 
and **P<0.01). (D) Representative images of lesion size determination through software analysis of altered areas in the tongues of the rats (scale bar in millime‑
ters). (E) Representative images of morphometric evaluation of bone loss. The distance between the cementoenamel junction and the alveolar bone crest was 
computed at 5 points in the second upper molar. (F) Representative histological section from a tongue receiving 4NQO stained with hematoxylin and eosin. 
(G) Representative images of epithelial dysplasia and invasive carcinoma from tongue. Cases presenting basal membrane invasion (indicated by arrows) were 
considered carcinomas. Perio, periodontitis; 4NQO, 4‑nitroquinoline 1‑oxide; SCC, squamous cell carcinoma. 
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expressed in the differentiation‑committed spinous layer of 
the oral mucosa, while basal cells do not express CK10 (22). 
Immunofluorescence staining for CK10 was performed, and 
positive basal cells were quantified. All histological fields 
presenting with abnormal basal cells expressing CK10 were 
computed as positive. A total of 398 fields were assessed 
in which 25.3% (4NQO) and 11.5% (4NQO/Perio) of the 

fields shown showed CK10 expression at the basal cells 
(Fig. 5A and B). These findings demonstrated increased 
abnormal activation of cellular differentiation of basal cells in 
4NQO‑treated animals compared with that in the 4NQO/Perio 
group.

Summary. Taken together, the present results suggest that peri‑
odontitis can influence the course of tumor development by 
reducing the differentiation of epithelial cells upon exposure 
to carcinogens. Differences in the rate of tumor transformation 
upon the presence of periodontitis were not conclusive in the 
present cohort of animals. Nonetheless, the development of 
periodontitis and exposure to 4NQO resulted in the increased 
size of oral lesions (Fig. 6).

Discussion

The role of periodontitis and its potential contributions as a 
risk factor/indicator in the development and/or progression of 
oral cancer by direct and indirect mechanisms have been the 
subject of interest and investigation in recent years (5,9). The 
majority of studies investigating the biological mechanisms of 
the association between periodontal disease and oral cancer 
mainly focus on P. gingivalis, a major etiological agent in 
the development of chronic periodontitis, yet not the only 
one (5,12,23‑27). To the best of our knowledge, no previous 
study has evaluated the impact of the dental biofilm on oral 
carcinogenesis and tumor progression. The present study used 
a ligature‑induced periodontitis animal model, as it shares 
similarities with the etiopathogenesis of periodontal biofilm 
accumulation following the alveolar bone loss observed 
in humans (28,29). This pioneering study indicated that 
biofilm‑induced periodontitis statistically contributes to the 
development of larger lesions in 4NQO‑induced oral carci‑
nogenesis. Furthermore, periodontitis associated with 4NQO 
administration showed a tendency to develop more epithelial 
dysplasia and oral carcinomas than animals receiving 4NQO 
alone (Fig. 4A and B); however, this latest finding was not 
statistically significant.

In the present study, the body weight of all rodents was 
assessed as a proxy for their systemic health. All animals exhib‑
ited increased weight during the experiment compared with 
the baseline. Notably, the average weight of the Perio group 
increased week on week over the whole experiment; however, 
there was no difference compared with the Control group, 
which is in accordance with the results of other studies (18,19). 
Regarding the groups exposed to 4NQO, there was ~10% less 
weight gain from baseline to the final week compared with 
that in the control groups, with a particular slight drop in the 
final four weeks, which is also in line with the results of other 
studies (15,30‑32). Significant differences were observed in the 
last weeks between the Perio group and the groups exposed to 
4NQO. A parallel may be drawn regarding water consumption, 
with groups exposed to 4NQO showing significantly lower 
water intake at various time points over 20 weeks compared 
with the control groups. Those differences in body weight and 
solution consumption observed between control and 4NQO 
groups are likely to occur due to the unusual taste of the 4NQO 
diluted in the drinking water during the first weeks of induced 
carcinogenesis, as proposed in the literature (15).

Figure 2. Morphometric alveolar bone loss evaluation. (A) Mean ± SEM 
level of alveolar bone loss in the ligature‑induced periodontitis sites in each 
experimental group (*P<0.05, **P<0.01 and ****P<0.0001). (B) Representative 
images of alveolar bone loss in the Perio, 4NQO, and 4NQO/Perio groups. 
The 4NQO/Perio group exhibited the largest distance between the cemen‑
toenamel junction and the alveolar bone crest. Perio, periodontitis; 4NQO, 
4‑nitroquinoline 1‑oxide. 
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The challenge of establishing periodontal etiopathogenesis 
mediated by ligatures and producing alveolar bone loss was 
successfully achieved (18,19). Exposure to 4NQO alone was 
sufficient to induce alveolar bone loss to similar levels as that 
found in the Perio and 4NQO/Perio groups. This result is in 
accordance with our previous study in which spontaneous 
alveolar bone loss was also observed in animals receiving 
4NQO, and enhanced when OSCC was present (21). Changes in 
the oxidative stress balance are among the possible mechanisms 
to support this association (33). 4NQO is capable of inducing 
oxidative DNA damage (34). In parallel, reactive oxygen species 
are capable of triggering periodontal tissue damage (35,36). 
Further studies may be necessary to elucidate whether the effect 
of 4NQO in periodontal tissue is a local response associated 
with the direct exposure of the oral mucosa and periodontium to 
4NQO‑diluted water or if this is a systemic effect.

To investigate the direct associations between periodon‑
titis and oral carcinogenesis without confounding factors, 
the present study used a well‑defined rodent animal model 
for inducible periodontitis in conjunction with the 4NQO 
chemical carcinogenesis protocol (15,37,38). Administration 
of 4NQO results in the formation of DNA adducts resulting in 
DNA damage and TP53 mutation, along with other hallmarks 
of tobacco‑driven oral carcinogenesis commonly observed in 
humans. In the present study, all animals exposed to 25 ppm 
4NQO showed alterations in the epithelium of the tongue 

during the 20‑week treatment period. Periodontal disease was 
induced using ligatures kept in place for the entire experi‑
mental period mimicking the biofilm‑induced periodontal 
disease found in humans (18,19). To the best of our knowledge, 
this is the first time that a ligature‑induced periodontal disease 
animal model and a 4NQO‑induced oral cancer model were 
implemented concomitantly to explore the potential correla‑
tion between periodontal disease and tumor progression.

We hypothesized that the presence of periodontitis would 
increase the incidence of oral cancer, as suggested in previous 
epidemiological and biological studies (5,9,13,39). The present 
study found a higher incidence of OSCC and dysplasia lesions 
in rats with periodontitis (4NQO/Perio) when compared with 
the 4NQO group. Although notable, statistical significance 
was not demonstrated in these findings. However, statistical 
significance was identified when comparing the tumor size 
of rats receiving ligatures and 4NQO (overall larger lesions) 
and rats receiving 4NQO alone. This finding is similar to 
the recent study that showed that chronically infected mice 
with P. gingivalis/F. nucleatum exposed to 4NQO in the 
drinking water presented with larger tumors and more lesions 
than animals without the pathogens (13,40). Also, it has 
been recently demonstrated that germ‑free mice exposed to 
4NQO and colonized with different oral microbiomes have an 
increased number and size of lesions compared with animals 
that receive 4NQO alone while remaining germ‑free (41).

Figure 3. Analysis of lesion size in 4NQO‑treated groups. (A) Mean ± SEM level of lesion surface area in each experimental group (***P<0.001), and individual 
tumor surface area in the 4NQO and 4NQO/Perio groups. (B) Representative images of tongue lesions and digital quantification in the 4NQO and 4NQO/Perio 
groups. The 4NQO/Perio exhibited the largest area. Moreover, a more heterogeneous lesion was observed, with large exophytic and verrucous regions, while 
the 4NQO group showed a more flat and homogeneous lesion (scale bar in millimeters). Perio, periodontitis; 4NQO, 4‑nitroquinoline 1‑oxide.
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During the analysis of the animal data in the present 
study, it became evident that tumors from the 4NQO group 
presented as focal alterations on the spinous layer of the dorsal 
epithelium of the tongue. Such alterations resembled the 

premature activation of cellular differentiation only observed 
on the uppermost layer of the mucosa, a phenomenon histo‑
logically described as dyskeratosis. The process of cellular 
differentiation is commonly found to be altered or lost during 

Figure 4. Histopathological analysis. (A) Percentage of cases diagnosed as epithelial dysplasia and carcinoma according in each experimental group. 
(B) Representative case showing microscopic findings in the 4NQO group. A carcinoma was present at the posterior portion of the tongue. Note the invasive 
characteristics of the dorsal carcinoma along local tissue destruction depicted by hematoxylin and eosin staining (inserts). (C) Representative example of 
4NQO‑treated rats depicting focal activation of cellular differentiation within the dorsal tongue mucosa. Epithelial cells exhibiting enhanced eosinophilic 
cytoplasm were present next to the basal layer of the mucosa (arrows). Perio, periodontitis; 4NQO, 4‑nitroquinoline 1‑oxide; OSCC, oral squamous cell 
carcinoma. 
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carcinogenesis, potentially exerting an important role in 
tumor behavior. Mechanistically, activation of cellular differ‑
entiation involves the regulation of cell polarity. Emerging 

findings show that several tumor suppressor genes are, in fact, 
controllers of cellular polarity, and loss of function of tumor 
suppressor genes directly impacts the maintenance of tissue 

Figure 5. Cell differentiation analysis. (A) CK10 basal layer expression by fields in each experimental group (****P<0.0001). (B) Representative images of CK10 
immunostaining (red) merged with Hoechst 33342 (blue) in the 4NQO and 4NQO/Perio groups. The 4NQO group contains CK10‑positive cells within the 
basal cells layer (white dotted line). By contrast, the 4NQO/Perio group lacks the expression of CK10 in the basal epithelial layers and just expresses CK10 on 
the upper layers of the epithelial layer of the mucosa. Perio, periodontitis; 4NQO, 4‑nitroquinoline 1‑oxide; CK10, cytokeratin 10. 
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homeostasis by disrupting symmetrical and asymmetrical 
cellular division (42,43). In order to investigate the effects of 
early carcinogenesis and the potential role of periodontitis in 
influencing tumor formation and progression, early changes 
in cellular differentiation on the dorsal mucosa of the tongue 
were investigated in the present study. Immunofluorescence 
analysis was performed for CK10, a major keratin and a marker 
of keratinocyte differentiation and keratinization commonly 
present on differentiating postmitotic keratinocytes (44,45). 
As this keratin is associated with epithelial differentiation, its 
expression is not expected in the proliferative basal cells of the 
mucosa. A recent study pointed out that the downregulation of 
CK10 expression in oral dysplastic areas can indicate malig‑
nant transformation (46). The present study found that rats 
receiving 4NQO presented with patches of basal epithelial cells 
with aberrant expression of CK10. CK10 was also expressed 
to a significantly higher level in basal cells from the 4NQO 
group (25.3% of fields) compared with that in the 4NQO/Perio 
(11.5% of fields). This result indicated that the presence of peri‑
odontitis reduces early activation of cellular differentiation, as 

evidenced by the downregulation of CK10 in this group, there‑
fore suggesting increased transformation potential. In fact, 
this result aligns with the observed increased size of lesions 
found in the 4NQO/Perio group compared with the group 
treated with 4NQO alone. Previous in vitro and in vivo studies 
suggested that CK10 may delay and decrease tumor formation, 
and that its presence in the basal layer inhibits cell prolifera‑
tion and prevents skin tumorigenesis (47‑50). Combined, these 
findings support the impact of biofilm‑driven periodontitis as 
an associated risk factor for OSCC progression, as it reduces 
the activation of the terminal differentiation process upon 
exposure to carcinogens. Although noteworthy, the study 
fell short of being able to define the role of periodontitis in 
the carcinogenesis process and increased cancer incidence. 
Despite efforts to recapitulate the process of carcinogenesis 
in humans using the tobacco surrogate 4NQO, faster tumor 
development was observed in the rats, limiting the study to 
20 weeks. The fast growth of tumors in rats contrasts with the 
lengthy accumulation of mutations and cellular transformation 
driven by tobacco consumption in humans. Such a fast and 

Figure 6. Diagram depicting increased cellular differentiation on the oral mucosa exposed to 4NQO and the presence of a smaller tumor area on the tongue 
of the rats. The presence of periodontal disease associated with the administration of 4NQO resulted in reduced cellular differentiation of the oral mucosa 
and the presence of larger tumor areas in the tongue of rats. Fig. 6 was created with BioRender.com. 4NQO, 4‑nitroquinoline 1‑oxide; CK10, cytokeratin 10.
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aggressive carcinogenesis process may have masked differ‑
ences in the tumor initiation process between the 4NQO and 
4NQO/Perio groups. Another limitation of the present study 
is the quantification of the tumor volume. 4NQO‑induced 
tumors are highly infiltrative and difficult to properly dissect. 
Following previously published 4NQO studies, in the present 
study, the tumor superficial extension was measured rather 
than attempting to calculate the tumor volume, in order to 
avoid the introduction of bias (20,51).

Nonetheless, even with the aforementioned limitations, 
a direct connection was established between the presence of 
periodontal disease with larger oral lesions and a dysfunctional 
cellular differentiation of surrounding mucosa. The clinical 
implications of these findings suggest careful follow‑up is 
required for patients with periodontal disease who smoke. 
Although the influences of periodontitis on cellular trans‑
formation and cancer initiation remain unclear, the present 
data suggest that periodontitis plays a role in the progression 
of tumors. Nevertheless, future studies need to be performed 
to better understand chronic inflammatory diseases from 
the oral cavity and their role in oral cancer development and 
progression.
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